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Adobe® Dreamweaver® CS3 
Note: This document remains as a help sheet for current users of Adobe 

Dreamweaver. Training for staff on the use of this software has now 

ceased, though advice will still be given. 

At this moment in time, the University is in the process of implementing a 

Web content management system (CMS), which will enable easier Web 

authoring and maintenance. This document does not address using the 

CMS, and advice should be sought from the Web Team if there is a need 

to create a new Web site within the University. 

INTRODUCTION 

When creating Web pages you must be aware of any rules and regulations set by 

your organisation or Internet Service Provider. If you are creating University Web 

pages they must comply with University guidelines and regulations. A „Code of 

Practice: Web based materials‟ document is available from 

http://www.brad.ac.uk/webid/guide/webcode.doc and must be adhered to. Pages 

must also conform to University regulations. Details of these regulations can be 

found at http://www.brad.ac.uk/lss/regulations/. 

On first mastering Web page creation, there is often a temptation to include every 

feature that you know. It is important not to lose the primary focus of your site – to 

convey information. You need to carefully design your site to ensure you succeed 

in this purpose. The Web Style Guide available on the Web at 

http://www.webstyleguide.com offers useful if not essential reading on Web page 

design.  Other documents and web authoring resources you may find useful are 

available from http://www.brad.ac.uk/lss/it-services/internet/resources/. 

Introduction to HTML 

All documents on the WWW, no matter how fancy they appear, are simple text 

files using Hypertext Markup Language (HTML) or Extensible Hypertext Markup 

Language (XHTML).  Put most simply, HTML or XHTML is the code that tells a 

Web browser how to display the contents of your Web document.  The browser 

does all the hard work and displays the contents in a formatted layout.  You can 

view the (X)HTML code of a Web page in Internet Explorer by clicking on the 

View menu and choosing Source.  If you want to know more about this, see the 

Weave your own Web document at: 

http://www.brad.ac.uk/lss/training/resources/weave/. 

Adobe® Dreamweaver® software is a Web authoring tool that offers you an 

easier way of producing HTML code.  It has many of the text editing features that 

are similar to those found in Word for Windows.  You can use Cut, Copy and 

Paste, Find/Replace and Spell Checking commands in the usual manner.  You 

can also move blocks of text by highlighting and dragging to a new location.  If 

you want to copy, rather than move, blocks of text, hold down the Ctrl key as you 

drag.  As you perform all these functions, Adobe® Dreamweaver® produces the 

http://www.brad.ac.uk/webid/guide/webcode.doc
http://www.brad.ac.uk/lss/regulations/
http://www.webstyleguide.com/
http://www.brad.ac.uk/lss/it-services/internet/resources/
http://www.brad.ac.uk/lss/training/resources/weave/
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HTML code in the background. Adobe® Dreamweaver® gives you the option of 

writing either HTML or XHTML. 

Web Accessibility 

The University and you as a Web author have both a moral and legal obligation 

to ensure pages on our Web server are universally accessible, particularly to 

those with disabilities.  The University‟s Code of Practice for Web based 

materials has adopted the recommendations of the W3C Web Accessibility 

Initiative - http://www.w3.org/WAI/.  This recommends that (X)HTML is used to 

organise and structure your page, and that Cascading Styles Sheets (CSS) be 

used to format and control the layout of the page.  This is similar to attaching a 

template to a Word document. 

This document will follow these recommendations and will, therefore, only cover 

the features that are used to organise and structure your page.  If you wish to 

change the formatting of your page, this should be done using CSS, which will be 

covered separately. 

Document conventions 

This document assumes knowledge of Windows and Office products, familiarity 

with University systems and experience of using a Web browser.  Guidance on 

these and other IT Services documents is available on the WWW at 

http://www.brad.ac.uk/lss/documentation/. Numbered paragraphs contain an 

action for you to perform. Others provide information. 

LEARNING OUTCOMES 

This document will take you step by step through the process of creating a Web 

site so that on completion you should be able to:  

 open, save and close documents. 

 edit and format text. 

 insert images and create links to other Web pages, e-mail addresses and 

bookmarks. 

 publish Web pages. 

GETTING READY 

Connecting to the M: drive 

Your M drive is your central UNIX file store that can be accessed from anywhere 

on campus or from remote locations.  The My Documents folder on computers in 

PC rooms supported by LSS point to your M: drive.  If you are using a staff PC 

you can use the steps below access your M drive.  For more information about 

your M drive, use the Staff Filestores quick link from the University‟s internal 

home page. 

http://www.w3.org/WAI/
http://www.brad.ac.uk/lss/documentation/
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1. Click on Start – UoB Apps – Utilities – Connect to M drive. 

2. When dialogue window appears enter your username and password (the 

ones you use for e-mail) and click OK.  It takes a little time to make the 

connection so please be patient. 

3. When you get a message that the M drive was successfully mapped, click 

OK. 

Downloading the files 

1. Open Internet Explorer and go to 

http://www.brad.ac.uk/lss/training/resources/dreamweaver/. 

2. Click on Download files. 

3. Click on Run – if you get a message saying the publisher could not be 

verified, click on Run. 

4. Click on Extract.  The files will extract to c:\dreamweaver-intro\ 

5. Close Internet Explorer. 

THE DREAMWEAVER WINDOW 

1. Open Adobe Dreamweaver CS3. 

2. Choose Deselect All in the Default Editor window. 

 

3. Choose Create New ... HTML if prompted.  

http://www.brad.ac.uk/lss/training/resources/dreamweaver/
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4. Right-click within the document window and select Page Properties. 

5. Choose Title/Encoding from the left menu and specify XHTML 1.0 Strict for 

the Document Type (DTD). 

6. Click on Ok. 

7. Click on the Code view and observe that the Doctype is set to XHTML 1.0 

Strict. 

8. Select Design view again. 

Enlarging the document window 

On the right and bottom borders of the document window you will see small arrow 

buttons.  Clicking on these will hide/unhide the panel groups and properties 

panel. 

CREATING A WEB SITE 

A Web site is a collection of related, 

linked Web pages. 

1. Open the Site menu and choose 

New site… to open the Site 

Definition window. 

2. Make sure the Advanced tab and 

Local Info in the category list are 

selected. 

3. Enter yournamesite as the Site 

name, substituting your name for “Yourname”. 

Panel groups 

Document window 

Properties panel 

Insert panel 
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4. Enter M:\yournamesite as the Local root folder. 

5. Click on OK. 

THE FILES PANEL 

When you create a Web, the site name and a folder list appear in the Files panel 

on the right. Once you have created files/folders in your Web site you can 

organise them in the Files panel in a similar fashion to using Windows Explorer. It 

is important that you carry out your Web site file management functions within 

Dreamweaver so that any hyperlinks to a page that you either move or rename 

are amended automatically. 

The Files group panel can be displayed or hidden by clicking on the Files link on 

the panel‟s title bar. 

SETTING PREFERENCES 

1. Click on the Edit menu and 

choose Preferences…  

2. Click on the General in the 

category list. 

3. The default settings are fine, 

however, Dreamweaver CS3 

will default to setting the 

spelling dictionary to English 

(US), which needs to be 

changed: 

i. Select English(British) from the Spelling dictionary drop down list. 

4. Click on New Document in the category list. 

5. Again, the default settings are fine; however, you need to change the Default 

Document Type (DTD) to XHTML rather than HTML.   

The Document Type tells any validator (see later) that you use to check your 

page, which set of standards to validate against. In addition, the latest 

versions of some browsers use this statement to determine how to display the 

page. For more information on use of document type declarations, see 

http://www.htmlhelp.com/tools/validator/doctype.html. 

There are several versions of HTML and XHTML standards.  If your Web site 

uses CSS we recommend the Strict version and if not, the Transitional 

version. 

For now, set the DTD to XHTML 1.0 Strict 

6. Click on Validator in the category list and set this to XHTML 1.0 strict; 

deselect any others. 

7. Click on OK. 

http://www.htmlhelp.com/tools/validator/doctype.html
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CREATING YOUR HOME PAGE 

Whenever you create a folder on the Web, it should have a folder with an index 

file in it.  If you enter a Web address into a browser that does not specify a 

particular file, the Web server defaults to delivering the index file, eg 

http://www.brad.ac.uk/internal/ delivers http://www.brad.ac.uk/internal/index.php.  

If you do not have an index file, a list of folder contents is displayed – see 

http://www.brad.ac.uk/img/ (we have deliberately left this without an index file so 

that staff can use images on the Web site). 

The starting page of your Web site is known as your home page and should 

always be an index file. 

1. If necessary, open the File menu and choose New. 

2. Select Blank Page, and then HTML from the Page Type column, and click on 

Create. 

3. In the document window, type your name, press the <Enter> key and then 

type 

This is the home page of my Web site. 

4. Click on Save icon  on the standard toolbar in the document window – if 

the toolbar is not displaying, open the View menu, choose Toolbars and click 

on Standard (CTRL + S can also be used to save your file). 

5. Type index.html as the filename. 

6. Click on Save. 

Notice that this file is now listed in your Files panel. 

You now need to set this as the home page to your site. 

1. Right-click on index.html listed in the Files panel. 

2. Choose Set as Home Page. 

PAGE VIEWS 

There are several ways of viewing your page.  You can 

switch views using the buttons at the top of the 

document window. 

Code – displays the HTML code. 

Split – splits the document window horizontally, displaying the HTML code in the 

upper portion and the WYSIWYG display in the lower. 

Design – shows a WYSIWYG (What you see is what you get) view. 

SITE MAP 

Before you start to create a Web site, you should design your site on paper and 

work out its information architecture.  This is a subject in itself and is beyond the 

http://www.brad.ac.uk/internal/
http://www.brad.ac.uk/internal/index.php
http://www.brad.ac.uk/img/
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scope of this course; however, once you have determined this you can use the 

site map to create this structure. 

1. In the Files panel, select Map view from the drop down list. 

Notice that the index.html file is display as an icon in the Files panel. 

2. Right-click on index.html and choose Link to New File… 

3. Type page1.html as the File name, and Page 1 as the Title and Text of 

link. 

4. Click on OK.  Note that a link to Page 1 is added to your home page. 

5. Repeat steps 2 and 3 to create page2.html. 

6. To create a further level in your structure, select one of your 

newly created pages and then create a link to a new page, 

called page3.html. 

Your site structure should now have three levels. 

You can expand the site map window by clicking on the Expand 

icon  in the Files panel. 

Linking to an existing file 

1. In Map view right-click on the index.html file and choose Link 

to Existing File. 

2. Change the Look in list box to point to c:\dreamweaver-intro\ 

3. Click on garden.html and choose OK. 

4. A message will appear to say that the files exist outside your root folder.  Click 

on Yes to copy the files. 

5. Repeat steps 1 to 4 to link to and copy jekyll.html and garden.jpg – note:  

you will need to choose All files from the Files of type list in order to see the 

graphics file. 

Removing links from the site map 

1. Click on the page3 icon and press the Delete key.  Notice that the link is 

removed from index.html. 

2. Repeat until only index.html remains. 

3. Return to the Local view.   

Notice that although you have removed the links from the site map, the files you 

created when making those links, ie page1.html etc, .still exist and are listed in 

the local view.  Unwanted files can be deleted by clicking on the file and pressing 

the delete key; you will be asked to confirm that you want to delete the file. 

Ensure that only garden.html, garden.jpg, index.html and Jekyll.html remain. 
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REFRESHING THE FOLDER LIST 

If you cannot see newly created/copied files, you may need to refresh the folder 

list: 

1. Click refresh icon  in the Files panel or press the <F5> key. 

FORMATTING 

Important! 

If you are creating Web pages for the University‟s Web site, the Code of Practice 

for Web based materials requires that you use HTML for formatting the structure 

of your pages and use Cascading Styles Sheets (CSS) for formatting the style, 

eg fonts, colours, etc, known as attributes. The exercises in this document reflect 

this and do not use style attributes.  (The use of CSS is beyond the scope of this 

document). 

If, however, you are creating Web pages for a personal site, you might want to 

make use of style attributes; these are covered briefly in the section on Attributes 

later in the document. 

Headings 

Document structure (or semantic markup) is a key factor in making a Web page 

accessible.  Any headings should, therefore, be assigned an appropriate heading 

style. 

1. Open garden.html by double-clicking on the filename in the Files panel. 

2. Ensure the cursor is somewhere within the heading 

paragraph 'GARDEN DESIGN'.  Notice that the status 

bar at the bottom of the document window shows that 

this is currently enclosed in <p> tags and is, therefore, 

formatted as a paragraph. 

3. Choose Heading 1 from the Format list box in the 

Properties panel (sometimes referred to as the 

Properties inspector). Notice that the tag now changes 

to <h1>. 

4. Move to the word 'Balance‟. 

5. Choose Heading 2 from the Format list box in the Properties panel. 

6. Apply the Heading 2 style to the following sub-headings:  'Strong Lines and 

Perspective' 'Texture', 'Colour', 'Some Famous Gardeners', and 'Some 

Garden Resources on the WWW‟. 

7. Save the file. 

Your page will now look like a well-structured Web document, with a prominent 

title and clearly defined sub-sections. 
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Paragraphs v Line Breaks 

Pressing <Enter> will begin a new paragraph and add white space. 

1. In the first sub-section (Balance) find the sentence that begins 'The main 

masses…‟ Insert the cursor before this and press <Enter> once. 

If you want to begin a new line without adding white space, press the <Shift> and 

<Enter> keys together. 

1. At the end of the document type your name. 

2. Press Shift and <Enter> to create a new line. 

3. Type University of Bradford. 

4. Save the file – you may need to click into your document to do this. 

Creating lists 

Bulleted/numbered lists 

1. Highlight the two paragraphs after the heading 'Balance'. 

2. Click on the Unordered list icon  in the Properties panel. 

3. Place the cursor after the sentence in the first paragraph that ends with 'an 

unsettled feel to it', and press return.  This will create a new list item. 

4. Press the backspace key to undo this action (or select undo from the Edit 

menu). 

5. Highlight the three paragraphs under the heading 'Strong lines and 

perspective'.  Format these as numbered paragraphs using the Ordered list 

icon . 

6. Save the file. 

Definition lists 

A definition list is designed to display a word or phrase on one line, and the 

definition of that word or phrase on the next line.  The definition line is indented. 

1. Highlight the text below the heading 'Some Famous Gardeners' (this section 

ends with 'novelist, poet and consummate gardener.'). 

2. Click on the Text tab in the Insert panel. 

 

NB If your Insert panel is displaying as a menu click on the button on the far 

left and choose Show as Tabs; to turn the tabs off, click on the icon at the far 

right of the Insert panel and choose Show as Menu. 

3. Click on the dl button to format your definition list. 

4. Click on the Code view and look at the tag settings for this section; <dt> and 

<dd> tags have been applied as necessary. 



Adobe® Dreamweaver® CS3 

January 2009 10 

5. Return to Design view. 

6. Save the file. 

Horizontal rules 

1. Move the cursor so that it is in front of the sub-heading Strong Lines and 

Perspectives. 

2. Open the Insert menu (rather than panel) and choose HTML. 

3. Choose Horizontal Rule. 

4. Save the file. 

Adding images to your page 

1. Ensure you are at the top of your Web page by pressing <Ctrl>+<Home> 

keys. 

2. Insert a blank paragraph between the heading and the first paragraph. 

3. Click and drag garden.jpg from the Files panel to the newly inserted 

paragraph.  The Image Tag Accessibility Attributes window will appear. 

You should always provide a text description for an image.  This is picked up by 

speech readers, and will also display on the page whilst the image is being 

downloaded or where users have chosen to view text only.  Think carefully about 

the text used as Search Engines can pick this up, especially when the graphic is 

the first item on the page. 

4. Type University of Bradford’s Web tutorial – photo of 

Haworth park. in the Alternative Text: box.   

NB Always end alternate text with a full-stop as this signals a screen reader to 

pause, which helps the listener.  If the image gave a lot of detail, you might need 

to consider providing a link to a longer description to ensure that a disabled user 

is not disadvantaged; you would need to create a new page to hold the 

description and then browse for this to create the link. 

5. Click OK. 

Notice that the image is inserted and the Properties panel displays the image 

properties, including the alternative text you have just added. 

The width and height of the image are also displayed in the Properties panel.  

Please note that you should not resize your graphic within Dreamweaver.  This 

should always be done in a graphics package and the graphic resaved.  Resizing 

in Dreamweaver may appear to produce the desired effect; however, the full-

sized graphic will be downloaded thereby increasing download times. 

6. Save the file. 
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Inserting links 

Dreamweaver makes it easy to create links to other documents, e-mail 

addresses, or other places within the same document. 

Creating a link to a related file 

1. Go to the definition list created earlier and highlight 'Gertrude Jekyll' (below 

the heading 'Some Famous Gardeners'). 

2. Click on jekyll.html in the Files panel and drag and drop this to the Link box 

in the Properties panel – don‟t worry if your mouse pointer changes to a no 

entry sign.  

3. Save the file. 

The filename is now displayed in the Link box and 'Gertrude Jekyll' is displayed 

as a hyperlink, ie in a different colour and underlined.  This is a relative link, 

which indicates where the linked page is located in relation to the current page. 

Creating links to files on the WWW 

In the example above, you were able to create a link by browsing the files stored 

within your Web site.  You cannot browse through files held on other computers, 

so, to create a link to a page not stored locally, you have to know the full Web 

address. 

1. Highlight the 'Royal Horticultural Society' (under the heading „Some Garden 

Resources on the WWW.‟). 

2. Click in the Link box in the Properties panel and type: 

http://www.rhs.org.uk 

3. Click in the document window to see the results. 

4. Save the file. 

'Royal Horticultural Society' is now underlined and displayed as a hyperlink. This 

is an absolute link. 

1. Now go to the bottom of your page and link “University of Bradford” to 

http://www.bradford.ac.uk. 

Note: 

For University Web pages linking to other pages on the University‟s Web site, 

please edit the hyperlink to remove http://www.bradford.ac.uk from the path, eg 

linking to the Learner Support Services Web site would use /lss/ rather than 

http://www.bradford.ac.uk/lss.  The helps to speed the download, and avoids any 

problems if the Web server has to be moved across to another server for any 

reason.  You will find information with more detail about absolute and relative 

referencing in the Weave your own Web document - 

http://www.brad.ac.uk/lss/training/resources/weave/weave.pdf 

http://www.brad.ac.uk/lss/training/resources/weave/weave.pdf


Adobe® Dreamweaver® CS3 

January 2009 12 

Linking within a page 

On long pages, make best use of the top portion of the Web page by giving the 

user an indication of what else is on the page that is not immediately visible. One 

way of doing this might be to provide a list of contents that enables the user to 

jump to different sections. To do this you need to provide each section with a 

bookmark:  

1. Place your cursor at the beginning of the sub-heading “Balance”. 

2. Click on Common on the Insert panel. 

3. Click on the named anchor icon . 

4. Type balance as the Anchor name. 

5. Click on OK.  Notice that a bookmark icon is displayed next to the sub-

heading. 

6. Repeat this for all the other sub-headings, amending the Bookmark name as 

appropriate, eg strong, texture etc. 

You have given bookmark names to the different sections of your document that 

you want to jump to and now need to provide links to those bookmarks. 

1. Under the image at the top of the page create a new paragraph and type 

Contents:  

2. Create an unordered (bulleted) list for the following:  

Balance 

Strong lines and perspective 

Texture 

Colour 

Famous gardeners 

Garden resources 

3. Highlight “Balance” in this list. 

4. Click and hold on the Point to file icon  that is to the right of the Link box in 

the Properties panel. 

5. Drag your mouse pointer to the bookmark icon at the side of the “Balance” 

sub-heading.  Your mouse pointer will change to an arrow as you do this.  

Release the mouse button and notice that the bookmark name is displayed in 

the Link box.  Note:  you can also use this method to point to files in your 

Files panel. 

6. Save the file. 

Having taken the user down the page, it is then good practice to provide a link 

back to the top of the page.  

1. Select the heading “Garden Design” and create a named anchor of top. 

2. Before each sub heading, create a new paragraph with the text [top] that 

links back to the bookmark top. 
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3. Save the file. 

Creating a link to an e-mail address 

1. At the bottom of the page type your e-mail address after your name and then 

select this. 

2. Click on the Email link icon  on the Common tab in the Insert panel. 

3. Make sure the Email Link window is displaying the correct information and 

click OK. 

Note that your e-mail address is now a hyperlink. 

Note:  Whilst it is possible to create an e-mail link for any text by selecting the 

text, eg your name, the Code of Practice for Web authoring requires that links to 

an e-mail address should always be displayed as the full e-mail address; the 

name of a person should link to a personal profile or Web page. 

4. Save the file. 

Attributes 

Note: These should not be used when CSS is used for styling a page. 

Many of the buttons on the Properties panel are similar to those of Microsoft® 

Office® products; however, it is important to remember that Dreamweaver is a 

Web authoring tool and not a word processor. 

1. Switch to or open index.html. 

2. Highlight your name and use the Properties panel to: 

i. Centre your name. 

ii. Format your name as Arial, 24pt Bold and Blue text – click on the text 

colour icon . 

iii. Format the paragraph of text as you wish. 

3. Now create a link to your garden.html file (refer to the section on Inserting 

Links if you have forgotten how to do this). 

4. Save the file. 

PREVIEWING YOUR PAGE 

1. Switch to or open garden.html. 

2. Click on the Preview/Debug in Browser list icon . 

3. If given a list of browsers, click on Preview in IExplore. 

Internet Explorer will open and display your Web page. 

4. Return to Dreamweaver. 
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PAGE PROPERTIES 

Page title 

Whilst it is possible to set text and background colours through the Page 

Properties this is best done using CSS.  It is, however, important that you 

always provide your Web page with a title.  This is displayed in the title bar of the 

Web browser when the page is viewed, is used as the bookmark/favourites 

name, is displayed as a header to the page when it is printed, and is often picked 

up by search engines as they crawl the Web.  Higher level pages should always 

reference University of Bradford in the page title (see the Code of Practice).  It is 

useful to use the Split view for this section so that you can see what changes are 

being made to the underlying code. 

1. Click on the Split view button. 

2. In the code view pane scroll to the top of the page so you can see the <head> 

tags.  Notice that your page does not have a Document Type identified (see 

page 5), although it has already got a <title>; however, this is incorrect as it 

refers to FrontPage rather than Dreamweaver. 

3. Click on the Page Properties … button in the Properties panel – you need to 

click in the Design view section of the split window to do this. 

4. Select Title/Encoding in the Category list. 

5. Select the text in the Title: text box and type Dreamweaver exercise – 

University of Bradford. 

6. Set the Document Type (DTD): to XHTML 1.0 Strict.  

7. Click on OK. 

The text in the <title> tags has now changed. 

The title of your page is also displayed on the document toolbar 

.  If you prefer, you can add/amend your page title 

here. 

Metadata 

Metadata is data about data. In HTML <meta> tags are used to contain data or 

information about a Web page and help to get your page picked up by search 

engine spiders.  For a brief explanation of metadata see 

http://www.ukoln.ac.uk/metadata/publications/nutshell/. 

Page description 

1. Place your cursor just in front of the <title> tag in the Code view. 

2. Choose HTML from the Insert menu (rather than panel). 

3. Choose Head Tags. 

4. Choose Description. 

http://www.ukoln.ac.uk/metadata/publications/nutshell/
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5. Type “The garden design exercise is used during staff 

training sessions to introduce Dreamweaver software”. 

6. Click on OK. 

Notice that the <meta> tag is added to the code view and that the Head icon has 

changed to display the Head: Description icon; clicking on this would take you 

directly to the description window.  

Keywords 

1. Place your cursor just in front of the <title> tag in the Code view. 

2. Choose HTML from the Insert menu (rather than panel). 

3. Choose Head Tags. 

4. Choose Keywords. 

5. Type Garden Design, Dreamweaver, Staff training, Learning 

Support Services, University of Bradford. 

6. Click on OK. 

You need to choose your keywords carefully as these could make the difference 

between someone finding your page through a search engine or not. Always try 

to think of the word/phrases that someone trying to find your page might enter. 

WORKING WITH THE FILES PANEL 

You should store all your images in an images folder as this avoids duplications 

and helps others to find the files. 

1. Right click on your site folder in the Files panel. 

2. Click on New Folder – a new folder is added with the name selected ready for 

you to give it a new name. 

3. Type images and press <Enter>. 

4. Click and drag garden.jpg to the images folder. As Dreamweaver recognised 

you have included this garden.jpg image in a file it prompts you to update the 

code of the page where it was originally inserted. 

5. Click on Update.   

6. Expand the images folder, if necessary, by clicking on the + icon to see the 

contents of the folder; you should see garden.jpg in the list. 

SPELL CHECKING 

Setting the language and spelling options 

1. Click on the Edit menu and choose Preferences…  

2. Select General from the category list. 

3. Choose English (British) from the Spelling Dictionary list. 
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4. Click OK. 

Spell checking 

Spell checking can be carried out in a similar fashion to that used in Word, by 

opening the Text menu and choosing Check Spelling. 

FIND AND REPLACE 

1. Open the Edit menu and choose Find and Replace. 

2. Choose Text from the Search list. 

3. Enter the text to be found, in this instance garden design. 

4. Enter the text to replace the above, in this instance garden layout. 

5. Click on Replace all. 

6. Save your file. 

TESTING AND PUBLISHING YOUR WEB PAGE 

Note:  If you are working through this document outside a class session and do 

not have Web space allocated to you, you will not be able to complete these 

sections. 

Setting the Remote and Testing Servers 

1. In the Files panel, click on the drop down list arrow to the right of your site 

name and choose Manage Sites. 

2. Ensure your site name is selected in the Manage Sites window that appears 

and click on Edit. 

3. On the Advanced tab, click on Remote Info in the Category list. 

4. Select FTP from the Access drop down list. 

5. Type www.student.brad.ac.uk as the FTP host. (To transfer files to the 

main Web server you would need to enter www.brad.ac.uk). 

6. Enter your login username and password. 

7. Click on Testing Server in the Category list. 

8. Select FTP from the Access drop down list. 

9. Enter dev-zone.cen.brad.ac.uk as the FTP host. 

10. Change the URL prefix to http://dev-zone.cen.brad.ac.uk/ 

11. Click on OK and then click on Done to close the Manage Sites window (don‟t 

worry if you see a message about caching). 
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Testing your files 

You should always use the development server – dev-zone.cen.brad.ac.uk – to 

test your pages to ensure that everything is OK before transferring them to the 

main Web server – www.brad.ac.uk.  However, only those with Web accounts on 

the main Web server can access the development server.  As you are going to 

put your files on the student web server using student accounts, you cannot 

access the development server and, therefore, cannot test your page 

beforehand.  You can, however, work through the instructions but be prepared to 

receive an error message. 

1. Switch to or open index.html. 

2. Click on the Preview/Debug in Brower list icon . 

3. If given a list of browsers, click on Preview in IExplore. 

Notice that this time you see a window that says “Connecting to yournamesite”.  

After this point you will get an error message, however, if you had an account on 

the development server it would continue to transfer your file to the test server 

and then display your Web page directly from the test server. 

After transferring your files to the Web server you should ensure they validate 

(see the next section) before moving them to the main Web server. 

Transferring files to the Web server 

Note:  When working through this section in class, you need to change your Test 

server host to www.student.brad.ac.uk. 

1. Click on index.html in the Files panel. 

2. Click on the Put File(s) icon . 

3. Dreamweaver recognises that this page links to garden.html and that 

garden.html includes the image garden.jpg. It, therefore, prompts you to 

also transfer these dependent files. Click on Yes. 

Your files have now been transferred. 

VALIDATING YOUR WEB PAGE 

It is important that you validate your Web page so that it is less likely to cause 

problems with different browsers and more likely to still work with the next 

browser release. W3C offer a free validation service at http://validator.w3.org/. 

Try validating your page: 

1. Switch to or open Internet Explorer. 

2. Open the W3C validator Web page -http://validator.w3.org/. 

3. Type the Web address of your page eg 

http://www.student.brad.ac.uk/username/garden.html in the 

Address box of the Validate by URL section. 

http://validator.w3.org/
http://validator.w3.org/
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4. Click on the Check button. 

The validation check will be performed and the results will be shown. Hopefully 

you should get „This Page Is Valid XHTML 1.0 Strict!‟  If not, you will need to 

check and amend your page until it does validate.  This is likely to necessitate 

amending the HTML code. 

When your page validates, we recommend you display the W3C symbol: 

1. Copy the code for the validation icon on the validation page. 

2. In code view, go to the bottom of the garden.html page and paste to code in 

just before the </body> tag. 

3. Save the file. 

4. Transfer the file across to the Web server. 

5. Repeat the validation process for your index.html file. 

CONGRATULATIONS! 

You have now produced a Web page and can check your document and its links 

by switching to Internet Explorer and entering the URL of your page in the 

Location text box, i.e. http://www.student.brad.ac.uk/username/ substituting 

username as appropriate. Do not forget to check that your file still validates (use 

the icon on your page) and that all the links still work. 

Note: 

Whenever you go to a Web address, the directory will be searched for an 

index.html file and the contents of this will be automatically displayed. If you 

name your file anything other than index.html then you need to add the filename 

to the Web address eg use http://www.student.brad.ac.uk/username/garden.html 

to open the page on garden design. 
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